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Introduction 
 
Lofting profiles in TurboCAD to create organic shapes is usually the route taken to create such things as 
airplanes, boats and cars. Since TurboCAD is not a NURBS (non-uniform rational B-spline) based 3D 
modeling package it is not always easy to get the desired results and occasionally a user must live with a 
lesser degree of precision. Be that as it may, these organic shapes can be created in TurboCAD with 
some planning, some experimentation and a strong desire to make it happen.  
 
The airliner in this tutorial will be approached more like one would proceed with a 3D modeling program 
than one might with precision CAD software, as has been seen in virtually all previous Textual Creations 
tutorials. Much of the detail will be created by 'tracing' strategically positioned and scaled airliner 
images. As such, a reader may find that the input data listed within the tutorial may not be exactly as 
what is seen on screen. This does not mean that the tutorial cannot be followed, but the reader must be 
aware that this is the case and that they must use their data in place of what is written in the tutorial. 
This will become clearer as the tutorial progresses and it is not something that should cause any grief. 
 
Within the tutorial the reader will be lead through each keystroke to produce every component of the 
airliner that is illustrated on the cover of the tutorial. The reader will learn how to create all the 
components using 2D profiles and modified 3D primitive shapes. The reader will learn how to insert 
standard lighting, how utilize render scene luminance and render scene environment. Additionally, the 
reader will learn how to render their drawing and save it in a high resolution image format. 
 
This tutorial is in no way intended to teach airliner design or construction, but rather it is intended to 
teach the use of some of the tools that TurboCAD has to offer and to introduce the new user to a drawing 
methodology. The author feels confident that the techniques outlined within the tutorial can help lay the 
foundation for future successful TurboCAD drawing and illustration for even the newest user. 
 
As with any technically advanced software, the user is generally faced with a steep learning curve. It is 
the hope of the author that the money and time spent working through a Textual Creation tutorial will 
help ease the learning and allow the reader to come away feeling confident that they made a wise 
decision. 
 
This tutorial will assume that the reader has the full edition of TurboCAD Pro V15.2 with the current 
Architectural and Mechanical add-ons, although no architectural or mechanical add-on tools will be used 
during the tutorial that the author is aware of. 
 
There are many ways to approach a project and it is likely that each person using the program would 
proceed in very different ways, so be open to alternative methods as experience builds. What is 
important is that the user becomes familiar with the objects that they wish to model and begin to look at 
them in a different way than they might otherwise do. What primitive shapes make up the whole? What 
will be required of these primitive shapes early in the drawing and how will this affect needs further 
along? What component or components should be started with? Many questions can only be answered 
through experience, but hopefully some of them will be answered by the time the beginner has worked 
through this tutorial. There is a great deal covered in this tutorial and the author urges the beginner to be 
patient, to read very carefully and to take the time necessary to do a good job. Try to enjoy the process as 
much as you will enjoy the final results. 
 
This tutorial assumes that the beginner has studied the desktop to some degree and can locate most of 
the tools. Since there are endless desktop configurations that can be set up in TurboCAD the author has 
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opted to illustrate the required tools with the V15 user interface, and the default toolbars in their 
undocked format (Office 2000 theme). 
 

 
 
This tutorial also utilizes a tool that does not come pre-packed with TurboCAD. It is the Copy in Place tool 
created by David Bell, based on an original macro by Winston Mitchell. It is available as a free download 
on the General Macros page at http://www.bcitool.com/. Please download it and install it as per the 
instruction that come with the download. It is truly an indispensable tool. Placement of the dll should be 
done with TurboCAD shutdown, so the dll will load when TurboCAD is started. 
 

 
 

 
 
This toolbar does not seem to show up as it once did when it was installed and TurboCAD was started. If 
this toolbar does not show up for the user, they will need to drag a copy onto an existing toolbar or create 
a new toolbar when TurboCAD is started. The tool is located under the second Copy Entities entry of the 
Customise dialogue. The category below the second Copy Entities, "Select By", also contains the two 
other tools that are part of the BCiTools_GM toolbar, should a user wish to add them to a toolbar. 
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If the reader is using Microsoft Vista or XP 64 and cannot get the Copy in Place tool to appear or function 
at all an alternate means of copying in place will be needed. This will be presented further along in the 
tutorial when the first copy in place is required. 
 
Some images have been supplied with the tutorial – please place the image wrapping images in a 
permanent location. 
 
Please remember that any supplied images and files are for use within the tutorial only and may not be 
shared or sold to others. 
 
The beginner should not overlook the importance of the internet as a resource for material to help 
understand the dynamics of what they are trying to model. If only to help gain a better understanding of 
what a user is modeling a Google image search and regular web search is time well spent. 
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Image Insertion & Scaling 
 
A 3-view image of an Airbus A320 airliner was located on the internet and opened in Photoshop. A 
selection was made of each view and each view was saved as a separate image. The three edited 
images have been supplied with the tutorial and they will now be inserted into the drawing, scaled and 
then aligned. These images will be used to help layout the lofting profiles and other shapes that will be 
required to create the airliner. 
 
Switch to Left view. 
 

 
 
Select Plane by Active View from the Workplane toolbar. 
 

 
 
If need be, zoom in with the scroll wheel so that the grid is visible on screen. 
 
From the Insert menu at the top of the TurboCAD desktop select Picture / From File. 
 

 
 
From the Look in dropdown menu locate the folder that contains the image Airliner Side View.jpg. From 
the Files of type dropdown menu select JPG files (*.jpg). Select Airliner Side View.jpg and then select 
Open. 
 

 
 
The image size and location must now be defined by two left mouse clicks or G SEKE snaps. In the upper 
left corner of the drawing area G SEKE snap to define the first corner of the image. Move the cursor in a 
right downwardly direction and G SEKE snap to define the second, and last, point of the image as 
indicated in the picture below. Size is not crucial in this procedure. In progress below. 
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In progress. 
 

 
 
Like so. 
 

 
 
The other two images will be inserted at this time as well. They will be inserted below this side view and 
will be rotated to their correct orientation after they have been resized. 
 
From the Insert menu at the top of the TurboCAD desktop select Picture / From File. 
 
Select Airliner Top View.jpg and then select Open. 
 

 
 
Just below the lower left corner of the first image G SEKE snap to define the first corner of the image. 
Move the cursor in a right downwardly direction and G SEKE snap to define the second point of the image 
as indicated in the picture below. Size is not crucial in this procedure. In progress below. 
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The airliner will be created along the coral line at X = 0. 
 

 
 
During the tutorial objects will be assigned to layers and turned on and off as needs dictate. 
 
Open the Design Director palette. 
 
Select the Create New icon at the top off the Design Director palette to create a new layer. 
 

 
 
Type Image Front View in the Layer name field and click OK or press Enter. 
 

 
 
In the same manner create three more layers called Image Top View, Image Side View and 2D. 
 

   
 
Turn off the four new layers by left mouse clicking the eyes icons that correspond to the new layers. 
Please note that layer 0 should remain visible at all times as the program uses this layer for internal 
processes. 
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Place the cursor over the forward semi-circle as the edge to fillet and then… 
 

 
 
…double click the same line to select the edge and perform the fillet. If it gives an error message about 
the size of the radius, retry with a slightly smaller start radius. 
 

 
 
Select the Shell solid tool from the 3D Modify toolbar. 
 

 
 
Tab into the Inspector Bar and enter -1 in the Thickness field. Press Enter. Note that a negative number 
shells inward and a positive number shells outward. 
 

 
 
Select the fuselage as the object to shell. Place the cursor over the sliced face and when it is highlighted 
left mouse click to select it as a face to omit. In progress below. 
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Select Finish. (Note a user can also double click a single face as a face to omit and perform the 
operation.) 
 
Fuselage Windows & Door Profiles 
 
Switch to Left view. 
 
Select Plane by Active View from the Workplane toolbar. 
 
Zoom in on the back window. 
 
Select the Rectangle tool from the Line toolbar. 
 
Select Blue from the color dropdown menu on the Property toolbar. 
 

 
 
Left mouse click by the upper left corner of the rear window. Move the cursor in a right downwardly 
direction for a short distance and then Tab into the Inspector Bar and enter 10 in the Size A field and 14 
in the Size B field. Press Enter.  
 

 
 
Press the Space Bar to exit the tool. 
 
An object can be moved orthogonally along one axis at a time by left mouse clicking the line that leads to 
the rotation handle. Select the new rectangle. Place the cursor over the line that leads to the X rotation 
handle and left mouse click to pick it up. 
 

 
 
Move the cursor right or left and left mouse click to place the rectangle central to the ink window. 
 

 
 
If need be, place the cursor over the line that leads to the Y rotation handle and left mouse click to pick it 
up. 
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Select the lofted object as the object to fillet. 
 
Select the two lower parallel lines and the bottom outer line as the edge to fillet. 
 

 
 
Select Finish. 
 
Press Ctrl + K to open the Select by Colors dialogue. Select Blue and click OK. 
 
Assign the selection to the 2D layer. 
 
Select the 3D Subtract tool from the Boolean & Facet toolbar. 
 
Select the Don't remove the subtrahend option. 
 
Select the lofted object (carriage) as the object to subtract from and then select the fuselage as the 
object to subtract. In progress below. 
 

 
 
Press the Space Bar to exit the tool. 
 
Select the carriage select and then select Explode 1X from the Format menu at the top of the TurboCAD 
desktop. This will allow the two components to be selected. 
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Press Ctrl + K to open the Select by Colors dialogue. Select Blue and click OK. 
 
Assign the selection to the 2D layer. 
 

 
 
Flap Track Fairings & Engine Mount 2D & 3D 
 
It is now time to create the flap track fairings and the engine mount. 
 
Turn on the Image Top View layer. 
 
Switch to World Plan view. 
 
Select the Triple Point Circle tool from the Circle/Ellipse toolbar. 
 

 
 
Select Blue from the color dropdown menu on the Property toolbar. 
 

 
 
Using three left mouse clicks place a circle over the left rear ink fairing as indicated in the picture below. 
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Select Finish. 
 
V SEKE snap the first point of the next line to the right vertex of the first blue line. Press and hold the 
Shift key down. Move the cursor up and left mouse click at the top right corner of the ink engine cowling 
to place the next point of the line. Release the Shift key. 
 

 
 
Select Finish. 
 
Select the Triple Point Circle tool from the Circle/Ellipse toolbar. 
 
Select Blue from the color dropdown menu on the Property toolbar. 
 

 
 
Using two V SEKE snaps, place the first two points of the circle at the two top corners of the engine 
cowling, as indicated in the picture below. 
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Move the cursor over the top ink line of the engine cowling and left mouse click to place the third point of 
the circle. 
 

 
 
Press the Space Bar to exit the tool. 
 
Select the Edit Tool from the Select toolbar. 
 

 
 
Select the large circle as the object to edit. Left mouse click on the red node to pick it up. Move the 
cursor to upper left corner of the cowling profile and V SEKE snap the node in place. In progress below. 
 

 
 
Left mouse click on the green node to pick it up. Move the cursor to upper right corner of the cowling 
profile and V SEKE snap the node in place. In progress below. 
 

 
 
Press the Space Bar to exit the tool. 
 
Turn off the Image Side View layer. 
 
Engine Profiles to 3D 
 
Select the Revolve tool from the 3D Object toolbar. 
 

www.textualcreations.ca


Donald B. Cheke                                                                                                                                                                                                       www.textualcreations.ca 

 142

Select Plane by Active View from the Workplane toolbar. 
 
Select the 3D Slice tool from the Boolean & Facet toolbar. 
 
Press and hold the Shift key down. Select the fuselage, the carriage and the tail as the objects to slice. 
Release the Shift key. 
 
Zoom in close on the nose of the fuselage and V SEKE snap to define the first point of the slice line. Press 
and hold the Shift key down. Move the cursor to the right for a short distance and then left mouse click to 
define the second point of the slice line. Release the Shift key.  Allow time for the program to calculate 
slices. In progress below. 
 

 
 
Select the Rectangle tool from the Line toolbar. 
 
N SEKE snap the slice line at the fuselage to place the first point of the rectangle. Move the cursor in a 
right downwardly direction for a short distance and then Tab into the Inspector Bar and enter 10 in the 
Size A and Size B fields. Press Enter. 
 

 
 
 

 
 
Select the 3D Slice tool from the Boolean & Facet toolbar. 
 
Press and hold the Shift key down. Select the fuselage, the carriage and the tail below the last slice as 
the objects to slice. Release the Shift key. 
 
Using two V SEKE snaps along the bottom of the 10" square define the slice line. In progress below. 
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Press Ctrl + K to open the Select by Colors dialogue. Select Blue and click OK. 
 
Assign the selection to the 2D layer. 
 
Switch to Isometric SE view. 
 

Materials, Blocks & Layers 
 
Because of all the rounded corners and lofted objects the drawing is pretty intense so most of the 
components will be turned into blocks. Since blocks should be created on layer 0 the components will be 
made into blocks before they are assigned to layers. Although materials can be applied to blocks after 
they are created via the Block palette edit function it is often better to do so in the current drawing since 
the lighting is already set up and the lighting in the block editing window is the default lighting and 
checking rendered objects there can be misleading. 
 
Note: A Block (used within TurboCAD) may be defined as a two or three-dimensional drawing (or object) 
that is created and stored for repeated usage in the current drawing. Blocks, like Symbols help fulfill the 
basic CAD rule of "Never draw the same thing twice". Blocks like Symbols are great time savers and, 
assuming the block or symbol has been precisely created, assure the user that the same precision will be 
there with any additional usage. It should be noted that every block that is used in a drawing is seen by 
the program as essentially one object. This is good as it ensures file sizes are kept to a minimum. Blocks 
can be edited via the Blocks palette but any change to a block in this fashion will occur to all instances of 
the block in the drawing. A Block can be resized in a drawing and it will retain its Block status, but this 
resizing may have consequences with regards to materials that have been applied to the original block. 
 
If a block is exploded its Block status is broken and it becomes just a regular drawing object. Any 
subsequent use or copy of that object will add to file size as any 2D or 3D object does. 
 
Double click on the main tail of the airliner to open the Properties dialogue. Under the 3D tab select 
Lacquer from the Category dropdown menu and Violet Techno from the Material dropdown menu. Select 
Edit Material.  
 

 
 
Left mouse click the icon by the Material dropdown menu to create a new material. Enter AL White 
Techno in the Name field of the New Material dialogue that opens and click OK. 
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Create a new layer called Side Windows and turn it off. 
 

 
 
Assign the selection to the Side Windows layer. 
 
Select the engine mount, and the larger portion of the cowling. 
 

 
 
Back on the Materials palette locate the Lacquer category and double click on the AL White Techno 
thumbnail to apply the material to the selected objects. 
 

 
 
Press Esc to deselect the selection. 
 
Select the two components of the turbine, and the engine cone. 
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Select all the tail components, including the signage and flap dividers. 
 
Select the Quality Rendering tool from the Render toolbar. 
 
Press Esc to deselect the selection after it renders. 
 

 
 
Switch to Isometric SW view. 
 

 
 
 
Select the Wireframe tool icon to end the render. 
 
Switch to Isometric SE view. 
 
Turn on the upper fuselage layer. 
 
Select the two upper fuselage objects and the two fuselage name plates. 
 
Select the Quality Rendering tool from the Render toolbar and allow time to render (~2.5 minutes for the 
author). 
 
Press Esc to deselect the selection after it renders. 
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Right mouse click the Wireframe render icon on the Render toolbar to open the Camera Properties. 
Check Quality, select Raytrace Full from the Rendering Mode dropdown menu and then click OK. Allow 
time for the render to occur. 3 min 13 seconds on the author's 'off the shelf' computer.  
 
Right mouse click on one of the Standard View icons to open the Named View dialogue. Select the name 
ISO 1 in the Name window and then click Modify. This will include the Raytrace Full setting in the stored 
view. Click Close. 
 

 
 
The airline looks nice but it could use some luminance lighting and an environment. 
 

 
 
Render Scene Luminance 
 
Standard lights are often all that is required for a scene, but luminance light can often perk up a scene to 
the next level. It should be noted that luminance lighting is required if a user requires light to pass 
through transparent or semi transparent materials. 
 
From the View menu at the top of the TurboCAD desktop select Lights. 
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